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INTRODUCTION

e For years Microsoft Office has been THE
reference suite

— For document production.
- For document exchange.

e Very soon infested by macro-viruses.
— Concept virus (1995).

o Still a real threat.
- E. g. China vs German chancery (2007).

e Need for an alternative?
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INTRODUCTION

Recent evolution
- Use free Office suite
— The best candidate: OpenOffice.
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Very popular:
— Seemingly no cost.

— Wrong feeling of security
« It is free and open therefore it is (or must be) secure! »

— Fully compatible with Microsoft Office
— ... more than Microsoft with itself.

e Worldwide use in civilian and governmental §inc|.

military) spheres. Official document format for:
- French Gendarmerie, French Ministry of Economy and Finance
- And many others in Europe...

Black Hat Briefings




4/20/09

INTRODUCTION

 The “natural” confidence in Open Software

" makes security analysis most of the times
useless.

e Question: it is possible to have both
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" security and openness at the same time?
_“e What the exact level of security with
respect to malware when considering OO.
= « BadBunny macro worm (2008).
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INTRODUCTION

* In 2006 and 2007 security analysis
showed that OO 2.x was absolutely not
secure.

—All data given to OO developers
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= « End of 2008, release of O0O3

—Presented as a significant evolution!
—What about security two years after?
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INTRODUCTION

e Our talk deals with an in-depth analysis
« 0of OO3 with respect to malware attacks

- How to exploit the confidence in
cryptographic primitives?
- How to design powerful attacks?
= o \WWe do not consider implementation
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= vulnerabilities!

e \We consider conceptual design flaws
only!

e \Wlog we consider OOwriter only!

Black Hat Briefings




4/20/09

INTRODUCTION

brevent stupid comments:
- We are not hidden Microsoft moles!
—There are problems for M$ too.

- But unfortunately less than for OO since it
has less powerful primitives inside.
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= o \We just want to make decision-makers to
= be aware of the existing risks

- ... and make them responsible, if such a thing
is possible!

— Reducing costs is most of the times not
compatible with security.
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AGENDA
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= ¢ Introduction.

= * History of OO 2.x security.

 ODF Format and Security Primitives.

=+ Viral Attacks through OO3 documents

—Unencrypted documents
—Encrypted documents
—Digitally signed documents

Conclusion: Enhancing OO Security.
Black Hat Briefings
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Demos
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"o A lot of demos to come.

e Complete code and techniques
= available in the white paper!

“e Fully and easily implementable by
malware in an automatic way.
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History of OO 2.x security
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002 Security History
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. ¢ First in-depth security analysis

- De Drézigué et al. (2006) Journal in Computer
virology

— Filiol & Fizaine (2007) Virus Bulletin Journal.

- Lagadec (2007) Journal in Computer Virology

e A lot of « hot » reactions.

- Many stupid, ideologic comments but who did

really read the papers?
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Qésiea

- 002 Security History (2)
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»® A lot of contacts with the OO developers
(German part)

— All proof-of-concepts communicated to them during
the OO International Conference in Lyon, France
(2006 ).

- We suggested to design the Trusted OpenOffice
suite:

e Parts or sensitive functions of the suite could be
enabled/disabled by the system admistrator
according to the security policy in place.

e To answer the permanent stupid comments,
we published technical data (Virus Bulletin).
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- 002 Security History (3)
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. ®* OpenOffice malware appear
— Proof-of-concept (Filiol & Fizaine, 2006 & 2007).
- — BadBunny (2007).
- What about the next ones?

"e Unfortunately, results are not taken into
® account!

— No real security concern.

— OO0 embed cryptography!

— The OO suite « spreads » more and more.

e
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SOPHOS

21 mai 2007

Ver SB/BadBunny-A

SB/BadBunny-A est un ver multi-plates-formes écrit en de nombreux langages scripts et distribué
comme un document OpenOffice.org contenant une macro StarBasic.

SB/BadBunny-A se propage en injectant des fichiers script malveillants qui affectent le comportement
de programmes IRC, mIRC et X-Chat populaires et provoquant I'envoi de SB/BadBunny-A a d'autres
utilisateurs.

Ces fichiers scripts malveillants sont nommeés badbunny.py (pour XChat) et script.ini (pour mIRC,
écrasant le fichier mIRC existant) et sont aussi détectés sous le nom de SB/BadBunny-A.

SB/BadBunny-A 1injecte différents composants supplémentaires sur la plate-forme sur laquelle 1l
s'exécute :

- Sur Windows, 1l injecte un fichier nommé badbunny.js qui est un infecteur de fichier JavaScript
aussi détecté sous le nom de SB/BadBunny-A.

- Sur Linux, 1l mjecte un fichier nommé badbunny.pl qui est un infecteur de fichier Perl aussi
détecté sous le nom de SB/BadBunny-A.

- Sur MacOS, 1l injecte un ou deux fichiers nommés badbunny.rb et badbunnya.rb qui sont des
infecteurs de fichiers Ruby aussi détectés sous le nom de SB/BadBunny-A.
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- 002 Security History (5)

» ® Which attacks were possible?

— Macro management modification:
e Change or pervert the macro security level
e Possibility to insert malicious macros in OO libraries

— Modification of the application menus (problem of
application integrity management). Interesting to use
with k-ary malware.

- Modify integrity of plain document (insert macro)
e Weak management of cryptography. Possibility
to transparently remove:

- Encryption.
— Digital signature.
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- 002 Security History (6)

. ®* We designed proof-of-concepts for technical
validation.

e We will not present the viral algorithmics:
— Not specific to OO but to macro viruses

- With OO3, nothing has really changed with respect to
the malware technologies

— Please refer to the bibliography.
e We are going to explain how to exploit user’s

confidence in cryptography (encryption,
signature) to design powerful malware attacks.
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0O0O3 Release

e December 2008: release of O03

nmo Presented as a major evolution of the suite

- Compatibility with Vista!
- A few bugs fixed
- Easy-to-useness increased

- But what about security?
- Are cryptographic (encryption, signature) a
real protection against OO malware.

- In fact most of the attacks still remain
effective!
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ODF Format and Security
Primitives.

ODF - Formal approach
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Configurations 2

Sans nom 1 .od!
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003 Macro Location
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m e Where are located macros in 003 documents?
— Located in a specific directory (one per language).

— Contains the files

e Script-Ib.xml (generic information with respect to
macros)

e Script-lc.xml (additional information + security flags)
Library:readonly="false’”
Library:passwordprotected=""false’”’

— The macro code itself!
— Demo 3
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003 Cryptographic Features
Formalization

OO03 security is based on
- Password-based encryption.
— Digital signature.

There are (too) many ways to apply them.
Need for a formal approach for an exhaustive
description.

Graph-based description
— Digital signature
— Digital Signature with encryption.
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003 Encryption
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s ¢ Blowfish in CFB mode.

— Use of 1V for key differentiation!
[}

o — In this respect far better than M$ Office (Filiol,
20009).

" ¢ Key derivation algorithm.: PBKDFZ2
"« SHA-1 for integrity.
e The manifest.xml file is itself not encrypted!
- Major weakness that can be exploited by malware!

e Demo 4
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003 Encryption (2)

L Macro and macro-related files are themselves
encrypted

— Demo 5

e As we will see, it is only an apparent
= protection in most critical cases.
O
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003 Signature
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- Let us recall that signature is THE cryptographic
primitive dedicated to give confidence about

- Document integrity
— Document origin (who is the sender)

e There are two ways of applying signature
- File > Digital Signature... menu
— Tools > Macros > Digital Signature... menu

e Based on X509 certificates
— Demo 6 (signature of document without macro)
— Creation of a documentsignatures.xml/ file

— Both the manifest.xm/ and documentsignatures.xml
files are not signed!
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003 Signature and Encryption
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L The overall structure remains the same.
- Refer to the white paper.

" The documentsignatures.xml is not encrypted!
— Another critical weakness!

| . .
e Let us now consider documents with macros.

- Two different cases to consider!
— But in both cases the critical files are not signed!
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File - Digital Signhature Case
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L A documentsignature.xml/ file is created

e The whole document is signed (including
macros) !

— Significant evolution compared to 002.
— Older attacks now fails!
- - But new ones are possible (see further)!

e Demo /

Black Hat Briefings
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Tools > Macros - Digital Signature Case

- A macrosignatures.xml file is created

e Only the macro tree is sighed (including the
macros)

— Possible to modify the rest of the document while
the user relies on partial signature!

— Other attacks are possible with respect to macros
(see further).

e Demo 8

ARARARAEAR
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Summary

- There is still critical weaknesses with respect to

signature and encryption implemenation/
management.

— A few older attacks from 2006/2007 are no longer
directly valid.

— New ones are possible.

Yo The existence of two different methods for

signature is non sensical and is bound to fool the
user and ease malware attacks.

e Cryptographic primitives provides a false sense
of security to the user!

e Let us now explain why.

Black Hat Briefings



Viral Attacks through OO3

documents
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Through Unencrypted Documents

No significant changes compared to 002.

Simple archive manipulations allow to perform a
lot of attacks.

- Modify the content.xml file (demo A1).
— Add files. Useful for document theft.

— Add macro.

— Substitute macros (demo A2)

ITTTTTTTT]
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No integrity management at all.

003 plain documents are very powerful malware
vectors.

Black Hat Briefings




T L) ‘*

LA

Mwhs 0wl
"

= =l = DD

T ==
@ C

s.;.
ni,

I
|

A
. R R R T
e .
o)
e
..
— e
Ly
- A
-
e \
-t » P
rewy.
- ::at.o-d - py
e ow
bepresreiill [
ra ’ (4 A . - S gme b
‘ ngaceron o | "
sty | Shma b |t ot |t Wy | SEVOR I e l
Socoegm | WUrewdan | emtedtond | it and m"",_ e | %
s pan |90 i3 - -0 = L3~ | ‘;
| . O
/ [ e Y a .
e e --I-. et A 15

L
o S g e b

L -:n-l |-.v <

— g
' s | Conmen
s
L* et
et — -
. oo
et - a
|
\
\
v
Yo ) wimn e d
W- vamrin
» LY
X o~ -
'—-.M» ::.N
7 S g
v 4 T
Uw—
-
maeiea
S




4/20/09

Through Signed Documents

Significant changes compared to 002.
It is no longer possible to
— Add a macro to a signed document
— Replace a macro with another (malicious) macro.

BUT OO3 signature provides the illusion of
security only!

Since there is no PKI yet to securely manage
signature:

- Man-in-the-middle attacks are very easy to revert
trust against the user

- Demo A4
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Through Sighed Documents (2)

Alice signs her document.

Charlie the attacker forges a Alice’s fake x509
certificate
- Very easy to recover the necessary information.

- Just read the meta.xml file (possibly of in a
previous document).
Charlie generates a Alice’s fake pair of keys and
signs the document in Alice’s name
(impersonation attack) after adding malicious
macros.

Bob the receiver checks the sighature and is
fooled.

A close look at certificates (Demo A5).
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Conclusion

Enhancing OO3 Security
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Protection measures

« Postpone use of O0O3 for critical use!

"+ Use external signature modules with PKI.

— French project Linagora (Open cryptographic component
EAL3+)

— _http:/Iwiki.services.openoffice.org/wiki/lmproving the digital signature Feature

"« Apply security policy rules
®  — Control of origin
— Control of contents
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Change the Design

* Files manifest.xml and meta.xml should be
encrypted to prevent information extraction.

« Semantic verification of the archive should be
implemented

— At the present time only the XML specification syntax is
checked.

— Implement A-calculus-based techniques!

* Design the Trusted OpenOffice suite

— Enable/disable functions/languages through an
administrator password.

e ...0ruse LaTeX!

ITTTTTTTT
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Thanks for your attention

Questions ?
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